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Mr. Gadget presents….
Bud Bondietti will demonstrate an array of electronic gadgets that he has been collecting,
when the Modesto PC User Group meets on Thursday, Sept. 22.
Bondietti, former MPCUG president, admits he is a gadgeteer from way back and pledges to
present “the newest items to help make computing easier.” These will include various storage
devices plus options for cooling laptops, optical wireless mice and keypads.
He also will introduce a program called Vox Proxy, which will allow the user to add animated
commentary to PowerPoint presentations.
The meeting will begin at 6:30 p.m. with the Random Access Special Interest Group, where
members can get their most pressing computer questions answered. Bondietti’s presentation
will follow a refreshment break at 7:30 p.m.
The group meets at Destiny Christian Center on Carver Road just south of Roseburg Avenue.
Use the side entrance on the south side of the building.

For directions to the meeting
location see page 10.

Next Meeting
Thursday, September 22,
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6:30 p.m.
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President’s Corner …. Mike Kumler
Happy autumn to everyone. Being from Michigan, I do miss the changing seasons. I especially enjoyed the autumn with the crisp nights and warm days. Enough!
MPCUG needs you!
With Claude’s illness, we are seeking a person to lead the Digital Photo SIG. I have spoken to Bud and he will
graciously continue to provide equipment as needed and Jim Goodman has stated that he will be attending the
meetings as well. However, we need a leader. If you have an interest in this leadership role, please contact
either Jim (SIG Coordinator) or me. We do not want to let this SIG slip away. It is a timely and popular subject.
We have decided that we need to have a permanent “set-up” crew. I am seeking one (or more) people to be
responsible for getting our meeting place ready and putting it back in shape after the meeting and coordinating
with Grant for opening and locking up. This person (people) will be assisted by Jim Goodman. I can see this
requiring about an extra 45 minutes each month and a very small effort. Again contact me.
On a lighter note, our Mr. Gadget will share some of those with us this month and next month we will be educated on building a computer. Should be lots of fun. The program from Intel about building a computer may
be of interest to others you may know who do not belong to our club.

Membership Report …. Hank Mudge
New members - Welcome to the club:
Donald Thill (8/06), Marcia Marrs (8/06)
Renewals - Thank you for your continued support:
Allan Romander (6/06)
Members’ dues expiring in September:
Joseph Snyder - Peter Scherf - Elizabeth Adkinson - Donald Branson
Members Dues Expiring in October:
Dorothy Libby - Vivian Neuman - George McMahon - Leonard Olives - Amberse Banks
Sid Losher - Glenn Davis

Have you ever wondered?
What makes my computer tick? Just what does the inside of my computer look like? How hard would it be to
build my own computer?
If these and other questions have ever crossed your mind, then next month will be a meeting not to miss. Intel
Corporation will be providing a presentation on Building your own computer with the opportunity to purchase
a good quality computer in a kit and then providing a seminar to build it as a group. Intel is a well known
manufacturer of computer chips and in conjunction with PC Club has provided a package so you can build
your very own computer. See next month’s Post for more details.
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Club Notes …. Club members, Officers
Meeting Location Help …. Jim Goodman
We need volunteers to assist with the following chores prior to and after each meeting. By performing these tasks, we
meet the church's criteria for keeping our meeting costs down:
Prior to the meeting:
Set up projector screen. Move chairs to back of room. Move tables.
After the meeting:
Put away projector screen. Return chairs. Move tables back. Clean up room. Take trash out and
replace plastic bags
If you can assist Jim with these tasks, please show up early and be willing to stay late.

SIG Meeting Dates
Beginners’ SIG - Denny's 1525 McHenry Ave, Modesto …............ Second Monday of the month
Random Access Q & A - Destiny Christian Center, Modesto …….. Fourth Thursday of the month prior to general meeting

Screen Shots ….
By David Garcia, President, Little Blue PC Club, Northglenn, Colorado
petitbleu@comcast.net
Have you ever wanted to print out what you see on your monitor screen? This is called a “Screenshot,” and
there are several software packages on the market that allow you to do just that with various degrees of sophistication. If you don’t need that sophistication, you can easily use Windows to get a screenshot. Just follow
these instructions:
1)
2)
3)
4)
5)
6)

Press the Print Screen Key (PrtScr) on the keyboard.
Click Start, then click Run.
Type “mspaint” (without the quotes) in the Run box and click OK.
In Paint, click Paste in the Edit menu
Click Print Preview in the File menu. If the screenshot is cut off, you may want to change the
printer setting to print in Landscape mode.
Click Print and close Paint. You’re done!

You can also save the file if you like:
1)
2)
3)

Click “Save” in the File menu
Browse to the folder you want to save the file in so that the folder name is in the “Save In” box.
Type a file name for the screenshot; use JPG in the “Save as Type” box and click Save.

Article rights are reserved. This article may be reproduced, downloaded, disseminated, or transferred, for single use by nonprofit organizations for educational purposes, with attribution to David Garcia. Little Blue PC
Club, Northglenn CO. It should be unchanged and this paragraph included. Please e-mail David Garcia at littlebluepcclub@comcast.net when you use it, or for permission to excerpt or condense.
There is no restriction against any non-profit group using this article as long as it is kept in context with proper credit given
the author. The Editorial Committee of the Association of Personal Computer User Groups (APCUG), an international organization of which this group is a member, brings this article to you.
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Claude’s Bytes ….
By Claude Delphia, Editor Emeritus, Modesto PC User Group
EdEmer@mpcug.net
Email considerations ● Cheap backups ● A privilege ends
Emails considerations — Each of us has our own way of dealing with the spam that ultimately gets through
to us. I currently get about 10 a day and sometimes none. This is compared to the 50-60 a day I used to get.
The spam I still get is marked with an “-s-” at the beginning of the Subject line. When I see this, I check first
to see who it is from. If I recognize the name, then I view it. If I don’t recognize the name, then the Subject
line becomes the point at which I determine if it is possibly from someone whose email I want to read.
Since I’m host to several areas of interest, such as genealogy and the Patterson website, I do get email from
people I’ve never heard from before. And I want this email. So I almost always check the subject line. Fortunately the spammers make it pretty easy to spot their crazy “come-ons.” You’d think they would be more inventive, but I’m glad they aren’t. The rest of the emails go directly to the trash unopened.
Have I missed an email I wanted? Maybe. But this goes back to a few things I’ve said here repeatedly. Don’t
assume an email was received unless it was acknowledged. If you really want to communicate via email, if
you get no response, send a second one. So if I failed to get your first email, send a second one. Of course if it
wasn’t important…
Ultimately, if you really need an answer, pick up the phone. Also keep in mind that the person you are
emailing may only read there email a couple of times a week. Email was never meant for instant contact.
Cheap new hard drives — Some of us who use our computers for business or projects find that our computers software and operating system become somewhat unstable after about 12 to 18 months of use and we
find ourselves at the point of having to backup and then reformat and reinstall all our programs. There just
doesn’t seem to be any reasonable choice despite all the features built into XP that should prevent this.
At first we see our computers slowing down — and we are using fast computers — and then we see a gradual
escalation of anomalies in the way our existing programs and hardware work. We may begin to see more
strange error messages that didn’t appear there a few months ago.
My current main computer is at that point after being built from the ground up in the spring of last year.
I do have to admit that some of the problems are of my own making. I’ve downloaded a number of trial versions of very large programs in order to decide whether they are something I may need to consider using. I
uninstalled them, but…
So now I’m considering my options. How do I transition to a new setup with relative ease? I’ve decided that
maybe my best option is to just leave the old (16 months?) hard drive in the computer and add a brand new
hard drive. Why would I do that? Because new name brand hard drives are getting unbelievably cheap. It
will clearly be easier to start with a new blank hard drive. No worrying about the data files on the old hard
drive as those will still be available on what will become a second drive. No reformatting will need to be
done. While reformatting isn’t a big deal, I’m feeling that this method will just be a cleaner and faster process.
One thing I’ve done over the last 18 months is to make sure that I have CDs of all my software and know
(Claude, Continued on page 5)
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(Claude, Continued from page 4)

where they are. In particular this includes software that I’ve downloaded. But if I keep the old drive in the
computer, I will also have downloads there to install on the new hard drive.
This wouldn’t have been a serious option a couple of years ago because hard drives just weren’t all that cheap.
But now it has to be a big consideration with some drives in the $50 range.
I’m thinking that more of us will see our older hard drives as simply something we keep in our computer as
backups or we take them out and store them away in case we need something off of one of them at some strategic point in the future. Don’t throw them away, just consider them as big non floppy backups.
A couple of caveats: Installing a hard drive is not something to be undertaken by the inexperienced. If you
have to pay someone to put in a new hard drive, you may need to consider reformatting your existing HD instead. Also it's not enough to just have your software ready to reinstall, you also need to make sure you have
your Software Key, the number that allows it to work legally. If you don't have all your software on original
CDs, you may need to consider other solutions. Resetting up is usually only an option for those who own all
their software.
A privilege — I enjoyed doing the eBay presentation at the last meeting. As I pointed out, it could only be an
introduction on how to buy and sell on eBay. Each individual has to decide how easily they can learn to eBay.
Some will need classes and others can just learn by trial and error. As I pointed out, eBay itself has a lot tutorials.
I did decide after the presentation, that it was my last for MPCUG. I just can’t physically prepare and make
these presentations anymore. We all eventually arrive at these points in our lives when we realize we can no
longer do what we did in the past and the decision was clear after this presentation.
I don’t remember when I made my first presentation to MPCUG, but it was probably in the earliest years of the
club when I led the “Lotus 1-2-3” SIG. In hindsight those were wonderfully simple years. Of course they
were simple, because our software did so little relative to today’s mega programs. We had no graphics, hardly
even knew what the possibilities were. We didn’t even have color monitors let alone being able to draw something or do serious page layout. And of course no Internet.
So while I have some regret that I can’t do any future presentations or classes, I have to be thankful for the
years when I could be a SIG leader and help others learn how to use their computers. It was always fun to see
someone learn something and quite often I’ve learned something too.
There is no restriction against any non-profit group using this article as long as it is kept in context with proper credit given
the author.

Tips and Tricks – Jumping between open programs
Often times I find myself with two or three and sometimes more open programs that I’m going back
and forth to. Although there are a number of ways to get back and forth between the programs, there are ways
to make that an easier job. First we’ll look at the menu command. If you look at the menu choices you will see
File

Edit

View

Document

Tools

Window

Help

Did you notice that the first letter besides being capitalized is also underlined? When you see an underlined
letter in the menu bar that means that when you hold down the “Alt” key and tap that letter that a menu will
appear and additional chores can be completed. If you hold down the “Alt” and tap the w key, the windows
menu will appear and at the end of the list is all the program files you have open. You can scroll down with the
September 2005
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Internet Explorer Tips and Tricks ….
by Richard O. Johnson, TUGNET rj@theskillspool.org
Internet Explorer, despite inroads made by Firefox and other browsers, overwhelmingly remains users'
browser of choice (perhaps because it comes bundled with all new Windows computers). The following pointers are designed to help you get the most out of your use of Internet Explorer. They're written with IE6 in
mind, although most will apply to earlier versions, and some may apply to other browsers as well.
Use keyboard shortcuts
My regular readers will know that to increase efficiency I strongly encourage the use of keyboard shortcuts in preference to the use of the mouse. Here are my favorite IE keyboard shortcuts:
•
Use Alt-Home to bring up your home page.
•
Use Ctrl-H to open or close your history pane.
•
Use Ctrl-I to open or close the Favorites pane.
•
Use Ctrl-B to organize your Favorites
•
Use Ctrl-N to duplicate the active page in a new window.
•
Use Ctrl-F to find a word, partial word, or phrase on the current webpage.
•
Use Backspace (or Alt-Left) instead of the IE Back button, to navigate back.
•
Use Alt-Right to navigate forward.
•
Use F11 to toggle full-screen mode.
•
Use Alt-D to move to the address bar. (Or use Ctrl-O, and you won't need the address bar! See
“Other” Tip 3, below, for details.)
•
Once in the address bar, use Enter to bring up the specified webpage or Ctrl-Enter to first sur
round what you've typed with “www.” before and “.com” after, and then bring it up.
•
Use F5 or Ctrl-F5 to refresh a page. It's a good idea when refreshing to routinely hold down Ctrl
(whether you're using the keyboard or the mouse), to bypass the IE cache and give you a more
effective refresh.
Optimize the toolbar
Unless you maintain only a dozen or so Favorites, you'll want to take full advantage of the Links option
for the IE toolbar, which you activate with the right-click toolbar menu. Drag the Favorites you'll want to have
most prominent into the Links section of the toolbar. Using the right-click Properties menu of each “Link,”
you'll probably want to assign it a unique icon and, to save space, rename it to a shorter form.
Tip: You can save additional space by shortening the “Links” title on the toolbar. Unfortunately, simply renaming the “Links” folder won't work. You'll need to open the Registry Editor, by choosing Run from the Start
menu and typing regedit. After pressing Enter, drill down to HKEY_CURRENT_USER > Software > Microsoft > Internet Explorer > Toolbar. On the right-hand side you'll see LinksFolderName=“Links.” Change the
word within the quotation marks to a one-character name you'd like to use instead, perhaps “.” or “+,” and
close the Editor. (Use extreme caution, as making a wrong entry in the Registry Editor can have dire consequences!)
You should unclutter the toolbar by instructing it to “Remove” nearly all the toolbar buttons. These not
only occupy valuable space but can actually interfere with efficient browsing (by discouraging use of the keyboard shortcuts described above). You get to the Remove command via “Customize,” on the right-click menu.
Of the built-in IE toolbar buttons, the only ones I recommend displaying are those for Size and Back. All the
other button functions can better be facilitated via the keyboard or by other means. (For a complete list of IE
keyboard shortcuts, go to http://snipurl.com/bskn. The reason for keeping the Back button is its associated pulldown menu.)
(Continued on page 7)
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Keep IE secure
It goes without saying that you need to keep IE fully patched, perhaps with the use of Windows Update
or Microsoft Update. But what of the Internet Explorer security settings (accessible via Tools > Internet Options > Security)?
In the “Internet Zone”--the default zone for a webpage--it's prudent to be more rather than less restrictive. (Better safe than sorry!) The easiest way to go is simply to move the “Default Level” slider to High. Or
you could use the “Custom Level” to make a determination for each setting. In that case you may want to consult a guide such as the one at www.techspot.com/tweaks/ie6/ie-5.shtml.
Remember that if your security restriction interferes with the proper viewing of a page, Windows will
let you know--although most often you'll be able to view the page just fine notwithstanding what Windows
says. To remove the restriction for a given page, you can add that page to your “Trusted” sites, against which
the restriction won't ordinarily apply. (You may have to refresh the page after adding it.) To simplify moving
webpages to your trusted list, a free program is available at www.geeksuperhero.com/zones.shtml.
An alternative method does not require you to move all such sites to the Trusted zone. For this you'll
need the laudable Push the Freakin' Button software, available at modest cost at www.tlhouse.co.uk/
PTFB.shtml. With PTFB in place, use IE's Custom Level to choose “Prompt” instead of “Disable” for every
feature except any that you're absolutely sure you'll never want to use. Then instruct PTFB to push the
“No” (disallow) button when the prompt appears. Should you decide to permit the feature in question, you can
with a double click disable PTFB, and just as easily re-enable it when done.
A good (free) test to assess your IE vulnerability may be found at http://snipurl.com/ietest.
Other tips
1.
To execute a link in a new window, hold down Shift.
2.
Is IE acting strangely? You can often fix it by using the IE Repair utility accessible via Add/
Remove Programs (in the Windows Control Panel), upon selecting “Microsoft Internet Ex
plorer” and then “Add/Remove.”
3.
You can dispense with the address bar, by using Ctrl-O to open a webpage or other location.
You can then completely hide the address bar (using the IE toolbar's right-click Customize
function) or shrink it down to its title only (having first “unlocked” the toolbar, also with the
right-click menu). Losing the address bar will eliminate the temptation to go there with the (less
efficient) mouse, and can free up space that may be better put to other use. On the downside,
you'll also lose the functionality of the Ctrl-Enter address bar shortcut (see Keyboard Shortcuts,
above).
4.
You might be able to save considerable time if you bypass your home page (start page) when
you don't need to see it. Here's how: Enter “about:blank” [without the quotes] in the IE address
bar, to create a blank quasi-webpage. Then use Right Click + F to turn that page into a Favorite,
and drag the new Favorite's icon into the Quick Launch section of your Windows task bar, be
fore deleting the Favorite. You may want to assign a different icon to your new IE shortcut with
the use of its right-click Properties menu. (You can use this same technique to set up a
“secondary home page” instead of a blank page.)
Add-ons
Useful IE add-ons, free except as noted, include:
•
Google Toolbar, at toolbar.google.com, which enables too many useful features to even hint at
here. Highly recommended.
•
Favorites Search, at www.dzsoft.com, which lets you speedily locate a Favorite, no matter how
(Continued on page 9)
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Tech News ….
By Sue Crane, Editor, Big Bear Computer Club www.bigbearcc.org
sue.crane@charter.net
Free services are being used to install malicious code
Cybercriminals are increasingly using blog sites, photo album sites, fan and greeting card sites and other free
online services to install and spread software designed to steal personal information or hijack a victim’s PC. In
the first two weeks of July, security company Websense saw more than 500 incidents of such attacks. The free
services are an anonymous and affordable way for attackers to store and spread their malicious code. Be careful what you click on!
Insect “extermination” via mini robots.
Scientists in Lausanne, Switzerland, have successfully infiltrated a colony of roaches with a micro robot according to a report published in the June issue of IEEE Robotics & Automation. Called InsBot, for “insect-like
robot,” the mechanical bug mimics the insects’ smell and movements so the roaches have accepted it as their
own.
Vector Capital purchases WinZip
WinZip,is one of the most popular shareware programs on the Web. More than 140 million people have
downloaded the program, and it’s downloaded for free about 500,000 times a week. Turnaround investor Vector Capital. will try to change that by reminding users a little more firmly that the software costs $29 (after a
free 30-day trial), as well as likely coming out with new features that only paying customers can download.
Better Eating Through Nanotech
Major food producers are using nanotechnology to improve the quality of their foods, although some warn that
the technology may be misunderstood by consumers. At a Nano4food conference food scientists, material scientists and nanotechnicians met to discuss how the technology is being used to improve the consistency of yogurt or cheese, packaging technologies, and even how to “wall off” the most nutritional components of food in
favor of tastier alternatives. However, as nanotechnology moves forward, consumers will have to be informed
and educated about the possible benefits and hazards of using it.
Microsoft Finalizes Genuine Advantage
Microsoft has gone live with the Windows Genuine Advantage program. The program, which has been available in an avoidable pilot version since late 2004, is now mandatory. Microsoft also noted that it has somewhat
simplified the Windows Genuine Advantage validation process; for example, users are no longer required to
enter a 25-character product key to validate their software. Users who try to validate software and discover that
they’re unwittingly (or otherwise) running illegitimate copies of Windows have a few options. According to
Microsoft, qualifying customers who fill out a piracy report, provide proof of purchase, and send in their counterfeit CD-ROMs can receive a genuine copy of Windows XP Home Edition or XP Professional Edition
(depending on which version they’re using) at no cost. Customers who submit a piracy report can get XP
Home for $99 or XP Pro for $149.
There is no “Superfetch”
Ed Bott, bestselling author and computer journalist advises: “The same yokels who insist on spreading the
“clean out your Prefetch folder” BS are now spreading the word that there’s a super-double-secret registry setting in Windows XP called SuperFetch that will reduce boot times dramatically. No, there isn’t. And if you see
any Web site that tries to insist that there’s any benefit to cleaning out your Prefetch folder or enabling this latest bogus tweak, you should assume that any other advice they give you is worthless as well.”
End of analog TV?
Millions of American television sets that receive only analog over-the-air broadcasts could go dark if not up(Continued on page 9)
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•
•
•

many you've stored.
Y!Q DemoBar, at yq.search.yahoo.com/splash/demobar.html, which enables context-based
searching. This can easily be squeezed onto the same line as the IE address bar.
ieSpell, at www.iespell.com, which will quickly spellcheck all the text you've entered in any
Web form.
AddaButton, at www.harmonyhollow.net/aab.shtml, which will let you fit more buttons onto
the IE toolbar. These buttons can open documents and applications (not just websites) and don't
require space-consuming displayed names. Shareware, $11.95

Richard Johnson is a writer and editor, and founder/administrator of FREE FOR ALL The Skills Pool, a 29-year-old membership organization (http://theskillspool.org). He is a volunteer with TUGNET HelpContact for assistance with Internet Explorer, Outlook Express, and Gmail. He welcomes feedback, at rj@theskillspool.org.
There is no restriction against any non-profit group using this article as long as it is kept in context with proper credit given
the author. The Editorial Committee of the Association of Personal Computer User Groups (APCUG), an international organization of which this group is a member, brings this article to you.
(Continued from page 8)

graded by Jan. 1, 2009. That deadline was suggested by members of the U.S. Senate’s Commerce, Science and
Transportation Committee. The committee is readying legislation expected this year that would require all
American televisions to run on digital signals by the end of 2008. That would free up the analog, or 700 MHz,
spectrum for other uses. Under current law, analog television would be cut off on Dec. 31, 2006, or when 85
percent of households are capable of receiving digital signals, whichever comes sooner. Last month, the FCC
proposed to move the date by which all televisions with screen sizes of 25 to 36 inches must contain digital
tuners up to March 2006. All televisions, VCRs and DVD players would have to carry the technology by 2007.
New Media Center Device
Microsoft will soon ship a wireless Media Center keyboard and remote control that will help people who have
Media Centers in their living rooms interact with the machines. The device features beveled edges for easy
two-handed holding, an integrated pointing stick, full Media Center remote-control functionality, a full-sized
keyboard with special Media Center buttons, and even power buttons for the PC and TV.
There is no restriction against any non-profit group using this article as long as it is kept in context with proper credit given
the author. The Editorial Committee of the Association of Personal Computer User Groups (APCUG), an international organization of which this group is a member, brings this article to you.
(Continued from page 5)

arrow key then select any of the window choices that appear.
Another option of course is the use the mouse pointer to select the program from the task bar at the bottom of
the window.
A third option is handy when the mouse dies and you’re in a hurry. By holding down the “Alt” again and tapping the “Tab” key a window will open up with all the programs that you have open. By repeating the “Alt”
“Tab” keystrokes you can move from program to program until you find the program you want to go to then
by releasing the keys that program will come up on the screen. This is especially handy when you are comparing two documents and copying and pasting between them.
For more helpful tips I suggest that you go to www.ask.com and type in computer tips and tricks to find more
helpful tips. If you find one that you think might help other computer users send them to Bud@mpcug.net and
I’ll include them in the next Tips and Tricks article.
Ed Mouse, Esq.
September 2005
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The Club’s
Meeting Place

Free classifieds for members. Email the text
to the editor at editor@mpcug.net

Our general meeting and the Random Access Special
Interest Group are held in the Destiny Christian Center, 1161 Carver Road, Modesto, on the west side of
Carver Road, right across from Sam’s Food City.

1161
Carver

For Information about our website host
and how you can get on board:
Click on this link info@fire2wire.com

Cyrano Writing & Editing
When you need help putting it in words, call Cyrano.

(209) 523-4218; 499-5401
Resumes, letters, applications,
articles, newsletters,
press releases, theses
Elizabeth Leedom

Need help hooking up
that new PC,
or installing DSL-Cable?
Call Jim Goodman, $60.00 for as
long as it takes. 579-0122
jgood99@sbcglobal.net
Modesto, Ceres Area

Be sure and check our web site at least once a week at www.mpcug.net
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President...................... Mike Kumler................. 531-2262………………. president@mpcug.net
Program VP.................. Elizabeth Leedom........ 523-4218…………….. programvp@mpcug.net
Secretary...................... Terry Fix....................... 524-8062….……....…… secretary@mpcug.net
Treasurer ..................... Barbara Cameron ........ 522-1389……………….. treasurer@mpcug.net
Director At Large......... Hank Mudge……………529-1936……….…... membership@mpcug.net
Appointed positions:

SIG Coordinator ............ Jim Goodman ………… 579-0122 ……...…….. sig@mpcug.net
Press Relations ............. .Elizabeth Leedom ........ 523-4218......................programvp@mpcug.net
Membership .................. .Hank Mudge …….…..…529-1936…..........…... membership@mpcug.net
Web Master................... .Jim Goodman............... 579-0122……………... webmaster@mpcug.net
Editor................................Bud Bondietti ................ 667-1980.................... editor@mpcug.net
PC Post

Editor: Bud Bondietti
Editor Emeritus: William “Doc” Holloway — 1920 - 1996
Claude Delphia, Editor Emeritus, 537-9604 — EdEmer@mpcug.net
Bud Bondietti and Elizabeth Leedom, Presidents Emeritus

Join The Modesto PC User Group
Web site: www.mpcug.net
To join MPCUG (or just get more information about us go to our Web site and fill out the new member form
or mail your check to: MPCUG, P.O. Box 5122, Modesto, CA 95352-5122.Membership is just $24 a year and
includes 12 issues of the PC Post along with participation in all meetings and events. You will also receive e-

The PC Post and Editorial Policy
The PC Post is published online 12 times per year and
is available to all group members as a membership benefit. Annual group membership dues are $24.
For information write:
Modesto PCUG PO Box 5122, Modesto, CA 953525122
Opinions expressed in the PC Post do not necessarily
reflect the opinions or views of the members as a group or
the Board of Directors.
The PC Post encourages group members to submit
articles for publication. We would like to have articles
which deal with the writer’s experience with computer
hardware and software.
An article may deal with any computer-related subject
provided it contains no libelous or offensive material. We
can’t use information copied from other publications
without written permission except for quotes.
Articles should be submitted in MS Word text. Do not
spend time formatting your article such as indents or centering. Please use only one space between sentences. and
do not use bold, italicize or otherwise format the submission as we can’t guarantee results in translation to Publisher. Proof read and run your spelling checker. Watch
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for special upper and lower case in brand names. Do not
tab or indent to layout text.
If you want to include a graphic, please contact the
editor for instructions.
We reserve the right to edit articles, for length or to
improve readability. Longer articles may be published in
several parts. We will not knowingly promote unlicensed
businesses.
Letters to the editor are encouraged. All articles and
letters to the editor should be submitted to the editor via
email as an attached file. Call him at (209) 667-1980 before submission. Please include your name, day and evening phone numbers, and email address for contact.
The MPCUG exchanges some articles with other user
groups around the country via the Association of PC User
Groups (APCUG). If for any reason you object to having
your article distributed to APCUG member organizations
for reprinting, please notify the editor at the time you submit the article. Your wish will in no way affect publication of your article in the Post.
Production notes: Prepared using Microsoft Publisher
2003, MS Office 2003, Minolta laser color printer and a lot of
sweat and a few tears.
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Special Interest Groups
SIG meetings are held at the discretion of the leader and participants.
Sometimes the date, location and time have to be changed or a meeting
cancelled. Give the leader a call before the meeting if it is your first time.
SIG Name

Leaders

Phone#

Date / Time / Note

Beginners’ SIG ……….. Bud Bondietti ………667-1980 ……… 6:30 p.m., 2nd Monday, Denny’s 1525
McHenry Ave.
Board Meeting ……...… Mike Kumler ……… 531-2262 ……… 7 p.m., 1st Wed. of the month.
Digital Photography…... C. Delphia ……..…... 537-9604 ……… 10 a.m., 1st Saturday, Harvest
J. Goodman ……….. 579-0122 ……… Presbyterian Church, Ceres
Random Access Q&A …………………………………....…..…… 6:30 p.m. before general meeting

Membership renewal: As with all organizations, MPCUG is run solely by volunteers. That
means that when your membership comes due, someone must send you a reminder, sometimes
several times. We try to cut back that need by e-mailing you that your membership is expiring.
Please help by renewing your membership in a timely manor. It saves user group money and

PC POST

Modesto PC User Group
P.O. BOX 5122

RETURN SERVICE REQUESTED

Time dated material
September
2005and check our web site at least once a week: www.mpcug.net
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